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1.  Copyright Notice
© Copyright 2018 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BVBA. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential
or incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2.  Curve Pilot and PressSync Pilot
If you have a PressSync license, you will get two applications after installing Curve Pilot on your
computer:

• Curve Pilot, which contains the IntelliCurve (DGC editor, strategy editor) and the PressSync
(PressSync curve set editor) functionality,

• PressSync Pilot, which only contains the PressSync functionality.

This document describes the PressSync functionality. For an explanation of the IntelliCurve
functionality, please see the IntelliCurve manual.
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3.  What is a PressSync Curve?
Curve Pilot / PressSync Pilot comes bundled with 400 PressSync curves. Those are pre-
defined dot gain compensation curves of various forms and shapes that can fit the dot gain
compensation needs of most presses.

Using PressSync curves significantly reduces the complexity of dot gain compensation in
workflows.

3.1.  PressSync Curve Names
PressSync compensation curves are defined by a letter (A to H) and a number (20 to 70): A40,
D20, F30, etc. The letter indicates the general shape of the curve in the highlights and in the
shadows. The number indicates the compensation value for the 50% dot (midtone).

20 50 70

A

E

H
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3.2.  PressSync Example Curves
The A50 curve increases dot gain in the highlights (forcing the press to print darker in the
highlights), and reduces dot gain in the shadows (thus forcing the press to print lighter in the
shadows). The H50 curve exhibits the opposite behavior. Both curves exhibit an inflection point
(where their slope changes sign) in the midtone.

 

 

The E70 curve increases dot gain throughout the tonal range, correcting the midtone to 70%.
The E20 curve decreases dot gain throughout the tonal range, forcing the midtone to 20%.

 

 

3.3.  Minimum and Maximum Values
A PressSync curve can also contain information about a minimum and a maximum value.

The minimum value is the correction / compensation for the first non-zero tone. For example,
if the minimum is set at 6%, the first tone value after zero will be adjusted to 6% as shown
below.
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Note:  Regardless of the minimum value you choose, the 0% tone remains at 0%. As a result,
the 0% tone will not be screened.

The maximum value is the correction / compensation for the tone just below 100%. For
example, if the maximum value is 96%, a tone of 99.5% for example will be corrected to 96%
and screened as shown below.

 

 

Note:

The 100% tone (the solids) will use the 100% level of the screen. This means that:

• for screens that do no use surface screening, solids will be kept as solids (not screened),
• for screens that use surface screening, solids will use the surface screening pattern defined

for 100% in the screen.
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Tip:

If you want to use your maximum value to screen the solids (so 100% is screened at 96% for
example), you should:

• use a flexible PressSync Curve,

• set the Maximum Value you want to use for screened your 100% tones,

• deselect the Keep 100% option in your curve.
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4.  Finding a PressSync Curve for a
Printing Ink

To find a PressSync curve for an individual ink, you need to print a vignette of this ink, measure
it and enter the values into Curve Pilot.

Note:  You can only do this in Curve Pilot, not PressSync Pilot.

1. Print a vignette of the ink you want to compensate with a PressSync curve (without using
any dot gain compensation).

2. In Curve Pilot, go to File > New > DGC (.dgc).
3. Enter your ink measurements as you would when creating a DGC curve (see the IntelliCurve

manual for details).
4. In the Show Curves area, make sure Compensation curve is selected, then select

PressSync curve.
This shows the best PressSync curve to use for your ink and printing conditions (press,
substrate...) with a red dotted line on the graph.
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You can see the PressSync curve name beside PressSync curve.

By default, the PressSync curve shown is the one that fits the compensation points the best.
The compensation points are the compensation values for each measurement you have
entered (they are shown as blue crosses on the graph).

5. If you want a PressSync curve that fits the smoothed compensation curve (blue curve)
better (instead of the compensation points), select Use Smoothed Curve.
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6. If desired, enter a Minimum Value and a Maximum Value to use for your PressSync curve

(see Minimum and Maximum Values for information).
The minimum and maximum values you entered are shown beside the curve name.

7. Save your curve:
a) go to File > Save,
b) enter a (meaningful) File Name for your PressSync curve,
c) click OK.
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5.  What is a PressSync Curve Set?
A PressSync curve set is a collection of predefined dot gain compensation curves, each
attached to an ink (a process ink or a spot color defined in Esko's CMS database).

Curve Pilot / PressSync Pilot creates and saves PressSync curve sets in the .prsync file format.
A .prsync file contains information about the desired printing condition, measurement data,
the actual dot gain compensation curves, and history data related to curve set setup and/or
measurement actions.

When sending a print job to your RIP application, you typically associate one or more .prsync
files with it. This way, every separation in your job is compensated with the appropriate
PressSync curve. For the details please refer to your RIP application manual.
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6.  Creating a PressSync Curve Set for
Your Press

You can create either :

• An empty curve set: manually pick the PressSync curves for your inks without measuring
your press output (for example if a third-party application gave you specific PressSync
Curves to use).

• A curve set with measurements: measure a few press runs and compare them to target
values to get your PressSync curves.

This way you can match a specification (ISO, GRACol, SWOP...) or another reference (if for
example you have a good curve set for one of your presses, and want to make a similar one
for a second press).

Note:  We recommend you create a curve set with measurements, rather than matching the
PressSync curves to your inks manually.

6.1.  Creating an Empty Curve Set
You can create an empty curve set if you are not planning to measure your press runs at all
and want to manually pick the PressSync curves for your inks. Do this for example if a third-
party application gave you specific PressSync Curves to use.

In Curve Pilot or PressSync Pilot:

1. Go to File > New then select PressSync Curve Set (.prsync).
In PressSync Pilot, you can also click the New... button at the bottom of the PressSync
Curve Set Explorer panel.

2. In the Create New Curve Set dialog, choose An empty curve set, and click OK.

This opens a dialog with an empty PressSync curve set.

By default, the curve set contains the four process inks (Cyan, Magenta, Yellow and Black),
and a channel called Other Inks (whose compensation will be used for any job ink not
defined in the curve set).

At the start, the Curve Name shows LIN (linear), which means that no compensation curve
is applied to those inks.
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3. Click Setup... to open the Setup dialog.
4. Enter your name in Changed by and a Reason for the setup change.
5. If desired, enter a Curve Set Description.

Note:  This will be shown in the  field of the curve set dialog (you can only edit the
contents of this field from the Setup dialog).

You will enter the Curve Set Name when saving the curve set.
6. Add extra inks to the curve set if desired:

a) click + at the bottom of the Spot Colors list,
b) in the Choose Inks dialog, choose the Ink Book,
c) choose or enter the Ink Name and click OK.
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When entering an ink name manually, you can use the full ink name or the short ink
name. Make sure you use either the exact spelling from your CMS database or the
official short name.

Note:  You can add any ink that is defined in Esko's CMS database, but you cannot remove
the default channels (Cyan, Magenta, Yellow, Black and Other Inks).

Tip:

If you are working on a curve set from/for a different system (with a different CMS), you can
add inks that are not registered in your CMS database:

1. Select <unregistered ink book> in the Ink Book field.
2. Type the name of your ink book.
3. The Ink Name field will show <unregistered ink>. Type the name of your ink.
4. You will see a warning. Click OK.

When working with unregistered inks, you will see a "U" icon ( ).

 

 
7. Click OK when you are done with the setup.
8. To assign curves manually to your inks:

a) Click Select Curve Names... in the curve set dialog.
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b) In the Select Curve Names dialog that opens, choose a PressSync Curve for each ink:
choose the letter, the number and enter a minimum and maximum value if necessary.

Note:  Linear means that no curve is assigned to the ink (so no dot gain compensation is
applied).
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Tip:

To view the curves you picked on the bottom graph, check their boxes under . You can

also click  to show all process colors curves, or to hide all curves.

 

 

You can click  to zoom in, then see different areas of the graph using the scroll bars or

your mouse, and click  to zoom out.

You can click a particular point of a curve to see its coordinates.
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c) Click OK when you are done.

You can now see the curves you have picked in the curve set dialog.

You can also view them on the graph, and zoom in and out.

 

 
9. Save your curve set:

a) Go to File > Save or use Ctrl+S.
b) Give your curve set a name and click OK.

6.2.  Creating a Curve Set from Measurements
To create a curve set with measurements, you need to measure a few press runs and
compare them to target values.
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You can either:

• Start from a standard curve set (delivered with Curve Pilot), if you want to compensate your
press output to match a target curve from a specification (ISO, GRACol, SWOP...).

• Start from an existing curve set, if you have already created a PressSync curve set that you
want to use as a basis for your new curve set. Do this for example if you have a good curve
set for one of your presses, and you want to make a similar one for a second press.

In both cases, you can use the predefined/existing setup and only take measurements from a
few press runs, or modify the setup to fit your needs before measuring your output.

1. Go to File > New then select PressSync Curve Set (.prsync).
In PressSync Pilot, you can also click the New... button at the bottom of the PressSync
Curve Set Explorer panel.

2. In the Create New Curve Set dialog:
a) choose either A standard or An existing curve set,
b) select the curve set you want to start from in the list,

Important:

Make sure you pick a curve set with the type of target you want, as you won't be able to
change it afterwards.

When starting from a standard, the standard name indicates the type of target you will
have to measure:

• standard names starting with 3ck (for example "3ck_GRAColG7.prsync") work with a 3
colors + K target (you will have to measure patches for two colors: a Cyan-Magenta-
Yellow composite and Black),

• standard names starting with cmyk (for example "cmyk_ISO_Newsprint.prsync")
work with a CMYK target (you will have to measure patches for four colors: Cyan,
Magenta, Yellow and Black).

Existing curve sets have the names you have given them. We recommend you include a
reference to the target in the curve set names. If you haven't, you can open the existing
curve set to check what kind of target it uses (in the Process Colors Setup on page 24)
before creating a new curve set from it.

Do not start from an "empty" existing curve set when creating a curve set with
measurements.

c) click OK.

This opens an untitled.prsync curve set in a dialog, with the inks and setup of the standard/
existing curve set you selected.

If you started from a standard curve set, you will see the four process inks (Cyan, Magenta,
Yellow and Black), and a channel called Other Inks (whose compensation will be used for
any job ink that isn't defined in the curve set).

At the start, each Curve Name shows LIN (linear), which means that no compensation
curve is applied on those inks.
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3. Customize your setup.
4. Take press run measurements to find the best PressSync Curve to use for each ink (see

Taking Press Runs Measurements on page 31).
We recommend print and measure a Universal Target then production jobs with a control
strip.

5. Save your curve set:
a) Go to File > Save or use Ctrl+S.
b) Give your curve set a name and click OK.

6.2.1.  Customizing Your Setup

1. Click the Setup... button in the curve set dialog to open the Setup dialog.
2. Use the Setup dialog to:
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• define the target values that your measurements will be compared to (for Process
Colors, Gray Balance and Spot Colors),

• add or remove spot colors to be compensated by your curve set.

For details, see:

• General Setup on page 22,

• Process Colors Setup on page 24,

• Gray Balance Setup on page 26,

• Spot Colors Setup on page 29.
3. Click OK when you are done with the setup.

General Setup
In the curve set's Setup dialog:
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1. Enter your name in Changed by and a Reason for the setup change.

You will enter the Curve Set Name when saving the curve set.
2. If you want to calculate the reference values (to compare your measurements to) from an

icc profile, select it in Target Profile Name.

If you started from a standard curve set, the corresponding icc profile is selected by default
(for example, GRACol2006_Coated1v2.icc if you started from 3ck_GRAColG7.prsync).

You can also select <none>, if you want to define the reference values manually.
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Note:  You can click on  to see information about the selected target profile.
 

 

You will see a Summary of the target curves selected for process colors, gray balance and
spot colors.

3. If desired, enter/change the Curve Set Description.

Note:  This will be shown in the  field of the curve set dialog (you can only edit the
contents of this field from the Setup dialog).

Process Colors Setup
In the Process Colors tab, you need to choose how to measure your process colors on print
(on a universal target or a control strip on the side of a job), and what target values to compare
your measurements to.

Note:

Depending on the curve set you started from (see Creating a Curve Set from Measurements on
page 19), you will need to choose either:

• target references / values for CMY and for Black,

• target references / values for Cyan, Magenta, Yellow and Black.
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1. Choose the unit of Measure to use for your press runs measurements. You can choose:

• density, to measure your patches with a "Status E" (for Europe) or "Status T" (for the US)
densitometer,

• %DotArea, to measure how much of the area is taken by the dot (in percentage),
• DeltaE-P, to measure the color difference between patch and paper (this is illuminant

dependant and based on CIE-1976),
• %DeltaE-SP, to measure the color difference between patch and paper, proportionally to

the color difference between solid and paper (this is illuminant dependant and based on
CIE-1976).

Tip:  Click  to see more information about the units.

You will need a densitometer if you choose density or %DotArea, and a
spectrophotometer if you choose DeltaE-P or %DeltaE-SP.
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This unit will be used to define the desired values for Paper and Solid, Universal Target
and Control Strip below.

2. In Target Curves, choose how to calculate the target values for process colors. You can
either:

• Select Use Profile for Tone Target Curves if you want to use data from the Target
Profile you selected in the General tab to calculate target values.

When you select this, the CMY and Black (or Cyan, Magenta, Yellow and Black) lists will
be greyed out.

• Select Linear (in the lists) if you want linear print values (without dot gain) as target
values.

• Select User Defined if you want to enter the target values manually instead of getting
them from a curve or a profile.

• Select any reference dgc curve present in the DGC or Curves database to calculate the
target values.

Tip:  If you want to start from predefined values but refine them for your needs, select the
predefined values first (Target Profile, Linear or a reference dgc curve) then select User
Defined. This will keep the predefined values but you will be able to edit them.

3. Check the desired values for Paper and Solid, and adjust them as necessary.
For example, if you chose to work with densities, adjust the density of paper and solid as
necessary.

4. For the Universal Target:

• If you have chosen User Defined in your Target Curves, enter the desired values for
1/4, 1/2 and 3/4 tones.

Note:  The Paper and Solid values are fixed. They are either 0% and 100% (if you are
using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper and Solid
(if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose in Target
Curves.

5. For the Control Strip:

• If you have chosen User Defined in your Target Curves, enter the number of Patches
you want to measure, their percentages and their desired values.

Note:  The values of the 0% and the 100% patch are fixed. They are either 0% and 100%
(if you are using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper
and Solid (if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose in Target
Curves, but you can still select the number of Patches and their percentages.

Gray Balance Setup
Checking Gray Balance is printing different intensities of gray using Cyan, Magenta and Yellow
inks, and measuring Lab values on the print to check how neutral the gray is.
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In the Gray Balance tab, you need to choose what target values to compare your gray prints
measurements to (for prints on a universal target or a control strip on the side of a job).

 

 

1. In Target, choose how to calculate the target values for gray balance. You can either:

• Select From Target Profile if you want to use data from the Target Profile you selected
in the General tab to calculate target values.

• Select User Defined if you want to enter the target values manually instead of getting
them from a curve or a specification.

• Select Neutral Paper if you want to calculate the target values relatively to the paper
and solid (using the paper's Lab values as 0% gray, the solid's as 100%, and calculating
the values in between).

• Select the built-in gray target of the specification (for example GRAColG7 (built-in) if you
started from 3ck_GRAColG7.prsync) to calculate the target values.
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You can click on  to see information about the selected target.

Tip:  If you want to start from predefined values but refine them for your needs, select
the predefined values first (Target Profile, Neutral Paper or the built-in target of the
specification) then select User Defined. This will keep the predefined values but you will be
able to edit them.

2. The Universal Target will contain a Light and a Dark gray square, composed of cyan,
magenta and yellow, with the cyan values fixed at respectively 25% and 50%.

• If you have chosen User Defined as Target:

• enter the desired magenta and yellow values for the Light and the Dark gray
squares,

• enter the desired Lab values of the cyan-magenta-yellow combination for the Light
and the Dark gray squares,

• enter the desired Lab values of the Paper and the Solid patch (100% cyan, 100%
magenta and 100% yellow).

• If you have chosen Neutral Paper as Target, enter the desired Lab values of the Paper
and the Solid patch.

The target values for the Light and Dark gray squares are calculated automatically.
• If you selected either the built-in gray target of the specification or the target profile as

Target, all the target values are calculated automatically.
3. The Control Strip on the side of a production job will contain patches of gray composed of

cyan, magenta and yellow.

• If you have chosen User Defined as Target:

• enter the number of Patches you want to measure,

• enter the percentages of cyan, magenta and yellow to print for each of those
patches,

• enter the desired Lab values of your patches, the Paper and the Solid patch (100%
cyan, 100% magenta and 100% yellow).

• If you have chosen Neutral Paper as Target:

• enter the number of Patches you want to measure,

• enter the percentage of cyan to print for each patch (the percentages of magenta
and yellow are calculated automatically),

• enter the desired Lab values of the Paper and the Solid patch (100% cyan, 100%
magenta and 100% yellow).

• If you selected either the built-in gray target of the specification or the target profile as
Target, enter the number of Patches you want to measure and the percentage of cyan
to print for each patch.

All the other values are calculated automatically.
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4. If you have chosen User Defined or Neutral Paper, you can also set desired Lab values for
the Solid Process Colors if desired (you can get those from your ink vendor).
Otherwise those values are defined automatically.

Spot Colors Setup
In the Spot Colors tab, you can add or remove spot colors. For each spot color you add, you
can choose how to measure it on print (on a universal target or a control strip on the side of a
job), and what target values to compare your measurements to.

You can also define what to do when encountering job spot colors that aren't defined in the
setup.

 

 

1. To add a spot color:
a) click + at the bottom of the Spot Colors list,
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b) in the Choose Inks dialog, choose the Ink Book,
c) choose or enter the Ink Name and click OK.

When entering an ink name manually, you can use the full ink name or the short ink
name. Make sure you use either the exact spelling from your CMS database or the
official short name.

Note:  You can add any ink that is defined in Esko's CMS database, but you cannot remove
the default channels (Cyan, Magenta, Yellow, Black and Other Inks).

Tip:

If you are working on a curve set from/for a different system (with a different CMS), you can
add inks that are not registered in your CMS database:

1. Select <unregistered ink book> in the Ink Book field.
2. Type the name of your ink book.
3. The Ink Name field will show <unregistered ink>. Type the name of your ink.
4. You will see a warning. Click OK.

When working with unregistered inks, you will see a "U" icon ( ).

2. Select the spot color you added to define its setup.
3. Choose the unit of Measure to use for your press runs measurements. You can choose:

• density, to measure your patches with a "Status E" (for Europe) or "Status T" (for the US)
densitometer,

• %DotArea, to measure how much of the area is taken by the dot (in percentage),
• DeltaE-P, to measure the color difference between patch and paper (this is illuminant

dependant and based on CIE-1976),
• %DeltaE-SP, to measure the color difference between patch and paper, proportionally to

the color difference between solid and paper (this is illuminant dependant and based on
CIE-1976).

Tip:  Click  to see more information about the units.

You will need a densitometer if you choose density or %DotArea, and a
spectrophotometer if you choose DeltaE-P or %DeltaE-SP.

This unit will be used to define the desired values for Paper and Solid, Universal Target
and Control Strip below.

4. Choose how to calculate the target values for this spot color. You can either:

• Select Linear if you want linear print values (without dot gain) as target values.
• Select User Defined if you want to enter the target values manually instead of getting

them from a curve.
• Select any reference dgc curve present in the DGC or Curves database to calculate the

target values (only when measuring density or %DotArea).

Tip:  If you want to start from predefined values but refine them for your needs, select the
predefined values first (Linear, or a reference dgc curve) then select User Defined. This
will keep the predefined values but you will be able to edit them.
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5. Check the desired values for Paper and Solid, and adjust them as necessary.
For example, if you chose to work with densities, adjust the density of paper and solid as
necessary.

6. For the Universal Target:

• If you have chosen User Defined, enter the desired values for 1/4, 1/2 and 3/4 tones.

Note:  The Paper and Solid values are fixed. They are either 0% and 100% (if you are
using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper and Solid
(if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose (Linear
printing or a reference dgc curve).

7. For the Control Strip:

• If you have chosen User Defined, enter the number of Patches you want to measure,
their percentages and their desired values.

Note:  The values of the 0% and the 100% patch are fixed. They are either 0% and 100%
(if you are using %DotArea or %DeltaE-SP as unit) or the values you entered for Paper
and Solid (if you are using density or DeltaE-P as unit).

• Otherwise, the values are calculated automatically based on what you chose, but you can
still select the number of Patches and their percentages.

6.2.2.  Taking Press Runs Measurements

We recommend you first print and measure a Universal Target to find the initial curves, then
refine those curves by printing production jobs and measuring their control strips.

Measuring a Universal Target
The Universal Target is a test form designed by Esko for setting up dot gain compensation
curves for your press. It is typically used when you have no idea about what PressSync curves
to use.

When measuring a Universal Target, you will look for where the target values (defined in the
setup) are in the vignettes. This will be used to calculate PressSync curves for each ink.

For example, if you find the target value for 50% Black at 40%, Curve Pilot will know that the
Black curve needs to compensate a 10% dot gain in the midtones.

1. Print a Universal Target without any dot gain compensation.
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Note:

If you have a good starting value, you can create a preliminary curve set and use it to RIP
and print the universal target.

For example, if you usually need to drop your midtones by 10%, you can use a curve set
containing an E40 curve for each ink. Concentric Screening users usually start from C45
curves.

See Using PressSync Curves in Nexus on page 47 or Using a PressSync Curve Set in FlexRip on
page 49 for details.

2. Click the Measure... button in the curve set dialog to open the Measure Curve Set dialog.
3. Select Universal Target and click OK.

This opens the Measure Universal Target dialog.
4. Enter your name in Changed by and a Reason for the setup change.
5. In most cases, you don't need to set anything in the Universal Target tab.

However, if you have printed the Universal Target with a preliminary curve set (see step 1),
you should:

• select The Universal Target is printed with different PressSync Curves,

• define the PressSync Curve used for each ink: choose the letter, the number and enter a
minimum and maximum value if necessary.

6. Go to the Process Colors tab and measure the process colors vignettes.
7. Go to the Gray Balance tab and measure the gray balance.
8. Go to the Spot Colors tab and measure the spot colors vignettes.
9. Click Results... to see the best PressSync Curves to compensate your measurements (see

Resulting Curves on page 34).
10.Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves
in your PressSync curve set.

• Save measurements only if you only want to save the measurements but not the
curves.

Note:  Keep the PressSync curve set dialog open as you will now be measuring a control strip.

Measure Process Colors
For process colors, you will be measuring either:

• the Cyan, Magenta, Yellow and Black vignettes if you started from a curve set working with a
CMYK target,

• the CMY and the Black vignette if you started from a curve set working with a 3 colors + K
target.

See Creating a Curve Set from Measurements on page 19 for more information.
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Attention:

Make sure your measuring device is configured to measure in the unit defined in the
setup (density, %DotArea, ∆E-P or %∆E-SP).

You can see the unit to use in the tab itself.

In the Process Colors tab:

1. Measure the solid patch of the vignette, and enter the value found in the Measured Solid ...
field.
Press Tab or Enter to enable the fields below.

2. Search for the 1/4 tone target value (that you defined in the setup).

Tip:  Start by measuring the 25% patch on the vignette, and move forwards or backwards
until you find the value you are looking for.

Enter that value in the leftmost field (<unit> of <value> found at: where <unit> is the
measuring unit you chose in the setup, and <value> is the target value you have set for the
1/4 tone).

3. Search for the 1/2 and 3/4 tones target values in the same way.

Enter those values in the middle and rightmost fields.
4. Repeat this for each vignette (either Cyan, Magenta, Yellow and Black, or CMY and Black).

Measure Gray Balance

Attention:  For gray balance, you will need a spectrophotometer, to measure Lab
values.

In the Gray Balance tab:

1. Measure the Lab values of the substrate and enter them in the L, a and b fields.
Press Tab or Enter to enable the fields below.

2. In the Dark Square, find the Lab target value defined in the setup.
Enter the coordinates of the position where you found that value (the X coordinate is a
letter, the Y coordinate a number).

3. In the Light Square, find the Lab target value defined in the setup.
Enter the coordinates of the position where you found that value.

Measure Spot Colors
Although the Universal Target is designed to be used for process colors, you can also use it to
print and measure spot colors.

To do this, make a copy of the Universal Target PDF file, and create a version that also contains
vignettes for the required spot colors (copy one of the process colors' vignettes and change its
ink settings).

Note:  The spot colors you use must be defined in the curve set setup.
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Attention:

Make sure your measuring device is configured to measure in the unit defined in the
setup (density, %DotArea, DeltaE-P or %DeltaE-SP).

You can see the unit to use in the tab itself (for spot colors, it is usually a colorimetric
unit: DeltaE-P or %DeltaE-SP).

In the Spot Colors tab:

1. Measure the solid patch of the first spot color vignette, and enter the value found in the
Measured Solid ... field.
Press Tab or Enter to enable the fields below.

2. Search for the 1/4 tone target value (that you defined in the setup).

Tip:  Start by measuring the 25% patch on the vignette, and move forwards or backwards
until you find the value you are looking for.

Enter that value in the leftmost field (<unit> of <value> found at: where <unit> is the
measuring unit you chose in the setup, and <value> is the target value you have set for the
1/4 tone).

3. Search for the 1/2 and 3/4 tones target values in the same way.

Enter those values in the middle and rightmost fields.
4. Repeat this for each spot color vignette, including Other Inks.

Resulting Curves

1. When you have entered all your measurements, click Results... to see the best PressSync
curves to use.
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Note:

You can also do this after entering the measurements for one or more inks, to see curve(s)
for the ink(s). For example, enter the Cyan measurements and click Results... to see the
Cyan curve.

You can then click Back To Measurements to go back and enter the rest of your
measurements.

You can see all the curves at the top of the dialog (Conclusion).

• The Process Colors tab shows the measurements you entered for the process colors
and the Gray Balance, and the resulting PressSync curve for each process color (in black
in the Result area at right).

• The Spot Colors tab shows the measurements you entered for the spot colors, and the
resulting PressSync curve for each spot color.
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Note:

If the PressSync curve found for an ink doesn't fit the compensation points calculated from
the measurements properly, it will be shown in red.

If no PressSync curve could be calculated because there are no or invalid measurements,
you will see -- instead of a curve name.

In that case, you can click the Back To Measurements button to verify your measurements.

If your measurements are correct (your press just prints that way), you should use Dot Gain
Compensation instead of PressSync curves. See the IntelliCurve manual.

2. In the Process Colors tab, you can:
a) Choose if you want to compensate mostly colors or mostly neutrals: in Select curves

based on, choose either:

• Tone measurements only if you want to pick curves that compensate mostly
process colors, and not gray balance,

• Both Tone and Gray Balance measurements if you want to pick average curves that
compensate everything (process colors and gray balance),

• Mainly Gray Balance measurements if you want to pick curves that compensate
mostly gray balance, and not process colors.

b) Click Preview Curves... to display each curve in a graph.
 

 

This shows:

• the original curve in gray,
• the new curve in black,
• the compensation points calculated from process (or spot) color measurements in

blue,
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• the compensation points calculated from gray balance measurements in gray,
• the standard deviation (Std), that shows how far the curve is from the compensation

points (this should be under 2% for the curve to fit properly).

Depending on what you chose for gray balance importance, the curve will be closer to
the process color compensation points or the gray balance compensation points.

3. In the Spot Colors tab, you can click Preview Curves... to display each curve in a graph.
4. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves
in your PressSync curve set.

Note:  If the Result area showed -- instead of a curve name, that ink's previous curve will
not be changed.

• Save measurements only if you only want to save the measurements but not the
curves.

This will save the measurement as incomplete, but you can edit it again or save the
curves later (see Continuing an Incomplete Measurement on page 42).

Measuring a Control Strip of a Production Sheet
We recommend you print a production job using the PressSync curves you found after measuring
the Universal Target. This job should have a control strip, that you will measure to refine your
PressSync curves.

Note:

You can use any type of control strip that contains several patches of each ink (for example
25%, 50%, 75% and 100%).

Make sure the patches of your control strip and what you have defined in the setup match. If
you do not have a control strip matching your setup, change the setup (see Process Colors Setup
on page 24, Gray Balance Setup on page 26 and Spot Colors Setup on page 29).

1. Use FlexRip or Nexus to RIP and print a production job (containing a control strip) using the
PressSync curves you found after measuring the Universal Target.
See Using PressSync Curves in Nexus on page 47 or Using a PressSync Curve Set in FlexRip on
page 49 for details.

2. Back in your Curve Pilot curve set, click the Measure... button again.
3. In the Measure Curve Set dialog that opens, select A control strip of a production sheet

and click OK.
This opens the Measure Production Sheet dialog.

4. Enter your name in Changed by and a Reason for the setup change.
5. In most cases, you don't need to set anything in the Production Sheet tab.

However, if for some reason you have printed the Production Sheet with a different curve
set than the one you found from the Universal target measurements, you should:

• select The production sheet is printed with different PressSync Curves,
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• define the PressSync Curve used for each ink: choose the letter, the number and enter a
minimum and maximum value if necessary.

6. Go to the Process Colors tab and measure the process colors vignettes.
7. Go to the Gray Balance tab and measure the gray balance.
8. Go to the Spot Colors tab and measure the spot colors vignettes.
9. Click Results... to see the best PressSync Curves to compensate your measurements (see

Resulting Curves on page 39).
10.Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves
in your PressSync curve set.

• Save measurements only if you only want to save the measurements but not the
curves.

Measure Process Colors
For process colors, you will be measuring either:

• the Cyan, Magenta, Yellow and Black vignettes if you started from a curve set working with a
CMYK target,

• the CMY and the Black vignette if you started from a curve set working with a 3 colors + K
target.

See Creating a Curve Set from Measurements on page 19 for more information.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the
setup (density, %DotArea, ∆E-P or %∆E-SP).

You can see the unit to use in the tab itself.

In the Process Colors tab:

1. Depending on what you have defined in the setup:

• Measure the 0% and 100% patches, and enter the values found in the corresponding
fields.

• Measure the solid patch, and enter the value found in the Measured Solid ... field.

You can see the desired value(s) defined in the setup between brackets.

Press Tab or Enter to enable the other fields.
2. Measure the other patches (defined in the setup) and enter the values found in the

corresponding fields.

You will see the desired values (defined in the setup) below those fields.
3. Repeat this for each vignette (either Cyan, Magenta, Yellow and Black, or CMY and Black).

Measure Gray Balance

Attention:  For gray balance, you will need a spectrophotometer, to measure Lab
values.
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In the Gray Balance tab:

1. Measure the Lab values of the substrate and enter them in the L, a and b fields below.

You can see the desired values (defined in the setup) between brackets below.
2. Measure the Lab values of the solid (100%) patch and enter them in the L, a and b fields

under the white patch.

Press Tab or Enter to enable the other fields.
3. Measure the other patches (defined in the setup) and enter the Lab values found in the

corresponding fields.

You will see the desired values below those fields.

Tip:  The numbers in the patches indicate the CMY composition (for example: 25, 19, 19 is
25% Cyan, 19% Magenta and 19% Yellow).

Measure Spot Colors

Note:  The spot colors you use must be defined in the curve set setup.

Attention:

Make sure your measuring device is configured to measure in the unit defined in the
setup (density, %DotArea, DeltaE-P or %DeltaE-SP).

You can see the unit to use in the tab itself (for spot colors, it is usually a colorimetric
unit: DeltaE-P or %DeltaE-SP).

In the Spot Colors tab:

1. Depending on what you have defined in the setup:

• Measure the 0% and 100% patches, and enter the values found in the corresponding
fields.

• Measure the solid patch, and enter the value found in the Measured Solid ... field.

You can see the desired value(s) defined in the setup between brackets.

Press Tab or Enter to enable the other fields.
2. Measure the other patches (defined in the setup) and enter the values found in the

corresponding fields.

You will see the desired values (defined in the setup) below those fields.
3. Repeat this for each spot color vignette, including Other Inks.

Resulting Curves

1. When you have entered all your measurements, click Results... to see the best PressSync
curves to use.
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Note:

You can also do this after entering the measurements for one or more inks, to see curve(s)
for the ink(s). For example, enter the Cyan measurements and click Results... to see the
Cyan curve.

You can then click Back To Measurements to go back and enter the rest of your
measurements.

You can see all the curves at the top of the dialog (Conclusion).

• The Process Colors tab shows the measurements you entered for the process colors
and the Gray Balance, and the resulting PressSync curve for each process color (in black
in the Result area at right).

• The Spot Colors tab shows the measurements you entered for the spot colors, and the
resulting PressSync curve for each spot color.
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Note:

If the PressSync curve found for an ink doesn't fit the compensation points calculated from
the measurements properly, it will be shown in red.

If no PressSync curve could be calculated because there are no or invalid measurements,
you will see -- instead of a curve name.

In that case, you can click the Back To Measurements button to verify your measurements.

If your measurements are correct (your press just prints that way), you should use Dot Gain
Compensation instead of PressSync curves. See the IntelliCurve manual.

2. In the Process Colors tab, you can:
a) Choose if you want to compensate mostly colors or mostly neutrals: in Select curves

based on, choose either:

• Tone measurements only if you want to pick curves that compensate mostly
process colors, and not gray balance,

• Both Tone and Gray Balance measurements if you want to pick average curves that
compensate everything (process colors and gray balance),

• Mainly Gray Balance measurements if you want to pick curves that compensate
mostly gray balance, and not process colors.

b) Click Preview Curves... to display each curve in a graph.
 

 

This shows:

• the original curve in gray,
• the new curve in black,
• the compensation points calculated from process (or spot) color measurements in

blue,
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• the compensation points calculated from gray balance measurements in gray,
• the standard deviation (Std), that shows how far the curve is from the compensation

points (this should be under 2% for the curve to fit properly).

Depending on what you chose for gray balance importance, the curve will be closer to
the process color compensation points or the gray balance compensation points.

3. In the Spot Colors tab, you can click Preview Curves... to display each curve in a graph.
4. Click Save... and choose to:

• Save curves if you want to save the measurements and the curves, and use those curves
in your PressSync curve set.

Note:  If the Result area showed -- instead of a curve name, that ink's previous curve will
not be changed.

• Save measurements only if you only want to save the measurements but not the
curves.

This will save the measurement as incomplete, but you can edit it again or save the
curves later (see Continuing an Incomplete Measurement on page 42).

Continuing an Incomplete Measurement
When a measurement was saved with the option Save measurements only, the
measurement is saved as incomplete (whether you filled in all the measurement fields or not).
The PressSync curves resulting from that measurement are not used for the curve set.

To edit it (if needed) and save the curves, do the following:

1. Make sure the incomplete measurement is active in the History (you should see , not 
beside it).
If it isn't, make it active (see Reverting to a Previous History Stage on page 46).

2. Click the Measure... button in the curve set dialog.
3. In the Measure Curve Set dialog, select Your last (incomplete) measurement and click

OK.
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4. Complete your measurement if needed, and save the measurement and the curves.

6.2.3.  History

When opening a PressSync curve set, you can see a History tab in the curve set dialog. This
contains any previously saved setups, measurements and curves, with the most recent stage
on top.

You can use it to:

• View the details of previous setups, measurements or curves.
• Revert to a previous setup, measurements or curves.
• Delete previous setups, measurements or curves that you are not using.
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For each history stage, you can see:

• its state:

• currently active ( ),

• active but incomplete measurement ( ),

• inactive and incomplete measurement ( ),

• inactive and not linked to the current setup (greyed out),

• what has changed (for example Measured Control Strip or Setup Change),

• the Curves resulting from that action,

• the Date and time of the change.
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Note:

Incomplete measurements (  or ) do not change the curves in the curve set.

Only complete measurements  and Manual Curve Change actions do.

So if your last action is an incomplete measurement, the curves in the curve set at that point
are those resulting from the last complete measurement or manual curve change.

To finish an incomplete measurement, see Continuing an Incomplete Measurement on page
42.

Viewing Previous History Stages
• To view a previous history stage, select it and click the Show Info button.

This shows all the details of the stage you selected (setup, measurement or manual curve
change), but in read-only mode.
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Reverting to a Previous History Stage
• To revert to a previous history stage, select it and click the Set Active button. It will get a

green flag .

• Setting a completed measurement active reverts to the PressSync curves resulting
from that measurement.

• Setting an incomplete measurement active reverts to the PressSync curves used to
print the sheet measured.

• Setting a Manual Curve Change active reverts to the PressSync curves set manually at
that time.

• Setting a Setup Change active reverts to the setup version created by the setup
change.

This can for example change spot colors or how to measure your prints.

Note:  Each measurement made is based on a specific setup version. When changing
the setup of the curve set or activating another setup version, the measurements
corresponding to other setup versions will be grayed out.

Deleting a Previous History Stage
To delete previous setups, measurements or curves that you are not using:

• To delete a previous history stage, select it and click the Remove button.

Attention:

You cannot delete:

• active stages (you need to first activate another stage instead),
• setup stages used by measurements (you need to delete the measurements

before you can delete the setup).
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7.  Using PressSync Curves and Curve
Sets

7.1.  Using a PressSync Curve in Imaging Engine
To apply a PressSync curve on your separations when ripping a job with Imaging Engine, enter
it in the Image to Screened Separations task.

1. In the Image to Screened Separations ticket, click the Separations tab.
2. In the Default Press Curve list, select PressSync.
3. Select the letter and number of the PressSync curve you want to use.

This applies that PressSync curve to all separations in your file.

Note:  If you have chosen to use the curves saved in your input file (see Use press curves from
file in the Imaging Engine documentation), your PressSync curve will only be applied to the
separations that don't have a curve defined in the file.

Tip:

If you want to use different PressSync curves for different separations, you can use a PressSync
curve set instead.

Select Curve Strategy in Default Press Curve, then select your PressSync curve set in the list
at right.

7.2.  Using PressSync Curves in Nexus
To use PressSync curves when ripping a job with Nexus, enter them in the Assemble
Separation activity.

1. Click the Change Symphony Control button at the bottom of the dialog.
2. In the Symphony tab of the pop-up that opens:

a) choose PressSync in the Press list,
b) select the letter (in Series) and number (in Value) of the PressSync curve to use for most

of your inks,
c) click OK.
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3. You can now see a PressSync column in the Assemble Separation dialog. Adjust the

PressSync curves of the other inks.
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7.3.  Using a PressSync Curve Set in FlexRip
To use your PressSync curve set when ripping a job with FlexRip, select it in your RIP ticket in
the Automation Engine Pilot.

• In the Dot Gain Compensation area of the RIP ticket, select your PressSync curve set
(.prsync) in the Automatic list.
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7.4.  Using PressSync Curve Sets in a Strategy
A strategy (.icpro file) is a combination of various curves, which allows you to compensate
different cases (different inks, screen rulings, dots, etc.) in a different way.

A strategy can use DGC curves or/and PressSync curve sets. Each curve or curve set is linked to
a specific case (for example: round dots + 120 lpi + linework).

For more information about strategies, see the IntelliCurve manual.

Note:  You can only create strategies in Curve Pilot, not PressSync Pilot.

To use PressSync curve sets in a strategy:

1. Go to File > New > Strategy (.icpro).
2. Build your strategy: use the buttons at right to create splits for different cases (per ruling/

dot/angle/...).
See the IntelliCurve manual for more information.

Note:  You shouldn't create splits based on inks as PressSync curve sets already perform
ink-based compensation.

3. For each case needing a PressSync curve set:
a)

click the DGC button  and choose  to use a PressSync curve set,
b) click the <none> column in the middle and select the PressSync curve set to use in the

list.
You can see the curves of the selected curve set at the bottom of the strategy editor.
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Note:  If you want, you can click Open... to open the selected curve set (to check or edit it).

4. Save your strategy under a meaningful name.
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8.  Viewing Curve Sets in the Preview
Combined Curves Tool

The Preview Combined Curves tool is useful when working with curve sets and/or strategies.
It lets you check which curve of the curve set/strategy will be used in a specific case (ink, ruling,
dot...).

It can also simulate what happens when using a combination of curves, for example plate
compensation together with press compensation.

8.1.  Previewing a PressSync Curve in a Curve Set

1. Go to Tools > Preview Combined Curves...
2. Depending on where you will use your PressSync curve set, select it either in the Automatic

Press or the Automatic Plate Making list.
3. In the Context area, select the ink whose compensation curve you want to preview:

a) in Ink Group, select the ink book containing your ink,
b) select your ink in Ink Name.

4. In the Curves area, you will see the name of the PressSync curve that will be used for your
ink.
You will also see the curve drawn on the graph.
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8.2.  Previewing a PressSync Curve Set in a Strategy

1. Go to Tools > Preview Combined Curves...
2. Depending on where you will use your strategy, select it either in the Automatic Press or

the Automatic Plate Making list.
3. In the Context area, define the case you are interested in:

a) Select either Images (CT) or Linework (LW).
b) Select the ink book containing your ink in Ink Group, and the ink in Ink Name.
c) Select the Dot Shape, Ruling and Angle you are interested in.
If some of those criteria are not relevant for your case, your don't need to fill them in.

4. In the Curves area, you will see the name of the PressSync curve that will be used in the
case you defined.
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You will see the curve drawn on the graph.
 

 

8.3.  Previewing a Combination of Curves
You can also use the Preview Combined Curves to see the compensation that will be applied
when using both press and plate curves.

1. Go to Tools > Preview Combined Curves...
2. Select the compensation to use:

• for your press in the Automatic Press list,
• for your plate in the Automatic Plate Making list.

You can select .icpro strategies, .prsync curve sets or legacy .scrdgc screen-based DGC files.
3. In the Context area, define the case you are interested in:
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a) Select either Images (CT) or Linework (LW).
b) Select the ink book containing your ink in Ink Group, and the ink in Ink Name.
c) Select the Dot Shape, Ruling and Angle you are interested in.
If some of those criteria are not relevant for your case, your don't need to fill them in.

4. In the Curves area, you will see the curves used both on the press and the plate for the case
you defined.
On the graph, you will see a curve that is a combination of those two curves.
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9.  Predefined Curve Sets for Printing
Standards

Curve Pilot comes with a number of predefined curve sets that you can use to help you match
ISO or GRACol printing standards.

9.1.  ISO Curve Sets
You should choose your ISO predefined curve set according to the ISO paper type you want to
print on:

• Type 1: gloss-coated, wood-free 93 (95)
• Type 2: matte-coated, wood-free
• Type 3: gloss-coated, web
• Type 4: uncoated, white
• Type 5: uncoated, slightly yellowish

Each ISO predefined curve set has specific Process Color and Gray Balance settings for one or
more ISO paper type(s).

Because ISO specifies tone targets for each individual process ink, the predefined curve sets
are designed to be printed on a CMYK target (and not a 3 colors + K target).

ISO PressSync Curve Set Settings for Process
Colors

Settings for Gray Balance

cmyk_ISO_PT1&2
(NP).prsync

• ISO 12647-2 (CMYK)
- Offset lithographic
processes

• Paper Types 1&2, gloss
matte coated – using
non-periodic screening
(Monet, Organic…)

• Target curves FOGRA
F (CMYK) as defined in
ISO 12647-2:2004

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
ISOCoated_v2_300_eci.icc profile.

cmyk_ISO_PT1&2.prsync • ISO 12647-2 (CMYK)
- Offset lithographic
processes

• Paper Types 1&2, gloss
matte coated

• Target curves FOGRA
A (CMY) and B (K)

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
PSO_Coated_300_NPScreen_ISO12647_eci.icc
profile.
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ISO PressSync Curve Set Settings for Process
Colors

Settings for Gray Balance

as defined in ISO
12647-2:2004

cmyk_ISO_PT3.prsync • ISO 12647-2 (CMYK)
- Offset lithographic
processes, web

• Paper type 3, standard
gloss coated (LWC)

• Target curves FOGRA
B (CMY) and C (K)
as defined in ISO
12647-2:2004

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
PSO_LWC_Standard_eci.icc profile.

cmyk_ISO_PT4.prsync • ISO 12647-2 (CMYK)
- Offset lithographic
processes, web

• Paper type 4, uncoated
white offset

• Target curves FOGRA
C (CMY) and D (K)
as defined in ISO
12647-2:2004ISO

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
PSO_Uncoated_ISO12647_eci profile.

cmyk_ISO_PT5.prsync • ISO 12647-2 (CMYK)
- Offset lithographic
processes, web

• Paper type 5, uncoated
yellowish offset

• Target curves FOGRA
C (CMY) and D (K)
as defined in ISO
12647-2:2004ISO

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
ISOuncoatedyellowish.icc profile.

cmyk_ISO_Newsprint.prsync• ISO 12647-3 (CMYK)
- heatset web offset
printing

• Paper type SNP,
Standard newsprint,
heatset web offset
printing

• Target curves FOGRA
C (CMY) and D (K)

The desired Lab values for the
different gray patches is calculated for
Neutral Gray (Lab linear scaled from
paper to solid).

The desired Lab values for paper
and solid are retrieved from the
PSO_SNP_Paper_eci.icc profile.
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ISO PressSync Curve Set Settings for Process
Colors

Settings for Gray Balance

as defined in ISO
12647-2:2004ISO

9.2.  GRACol Curve Sets
The GRACol standard uses gray balance to calibrate the tonal range on press (instead of relying
on measurements for each individual process color).

Because of this, the GRACol predefined curve sets are designed to be printed on a 3 colors + K
target (and not a CMYK target).

GRACol PressSync Curve Set Settings for Process Colors Settings for Gray Balance

3ck_GRAColG7.prsync • GRACoL G7 (3C+K) -
Commercial Offset
Lithography

• Paper ISO 12647-2 Type
1&2 (gloss and matte
coated)

• Target curves for K and
CMY: GRACol G7 K.dgc and
GRACol G7 K.dgc

Curve Pilot has a built-in gray
target calculated from the
GRACol G7 specs, containing
the desired Lab values for the
gray patches, paper and solid.

3ck_SNAP.prsync • SNAP (3C+K) – Newsprint

• Paper ISO 12647-3

• Target curves for K and
CMY calculated from the
SNAP2007.icc profile

The desired Lab values for the
different gray patches, paper
and solid are retrieved from
the SNAP2007.icc profile.

3ck_SWOP.prsync • GRACoL G7 (3C+K) -
Commercial Offset
Lithography

• Paper ISO 12647-2 Type
1&2 (gloss and matte
coated)

• Target curves for K and
CMY: GRACol G7 K.dgc and
GRACol G7 K.dgc

Curve Pilot has a built-in gray
target calculated from the
GRACol G7 specs, containing
the desired Lab values for the
gray patches, paper and solid.
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